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RESUMO

O futebol jogado por rob6s passa a ser interessante devido ao fato dessas maquinas ndo serem contro-
ladas por humanos, mas sim por uma inteligéncia artificial presente em um computador. O fato desse
desafio permitir que seus integrantes apliquem os conhecimentos obtidos em sala de aula também

colabora no &mbito de incentivar os estudantes a desenvolverem esse complexo sistema.

A monografia trata exclusivamente do projeto da placa principal do rob6, responsavel por executar a
comunicagdo, o processamento de dados e a movimentagdo da plataforma robdtica. Dessa maneira,
temas como mecanica do robd, inteligéncia artificial e visdo computacional estdo fora do escopo desse

estudo, apesar de serem vitais para o futebol de robds.

Os principais softwares utilizados para projetar e construir a placa eletrénica foram o MPLAB IDE,
para realizar a programacdo e emulacdo do codigo, Eagle 5.4.0, com a finalidade de implementar as
interligacGes entre os dispositivos e seus posicionamentos na placa, e o CircuitCAM 5.2, apenas para

converter os arquivos gerados pelo software anterior para um formato compreendido pela fresa.

Ao final da monografia espera-se ter em méaos o projeto de uma placa robusta, capaz de atender a to-
dos os requisitos exigidos pela sua aplicacdo, para tanto, todos os componentes foram estudados e 0s

maodulos testados em protoboard, para entdo consolidar o projeto.

Mesmo com todo o cuidado e estudo para concretizacdo do projeto, melhorias sdo propostas nos topi-
cos finais, possiveis por meio de novas abordagens de certos temas, utilizacdo de tecnologias diferen-
tes, devido & maior disponibilidade de recursos monetarios ou até mesmo ao maior tempo de dedica-

¢do a execucdo.

Palavras-chave: futebol de robds, placa principal, robd, projeto, Eagle 5.4.0.



ABSTRACT

The football played by robots becomes interesting due to the fact that these machines are not con-
trolled by humans, but by an artificial intelligence present in a computer. The fact that this challenge
enables their members to apply the knowledge obtained from in-classroom also helps in encouraging
students to develop this complex system.

The monograph deals exclusively with the design of the main board of the robot, responsible for ex-
ecuting the communication, data processing and movement of the robotic platform. This way, subjects
such as mechanical robot, artificial intelligence and computer vision are outside of the scope of this
study, despite being vital for robot soccer.

The main softwares used to design and build the electronic board were the MPLAB IDE to perform
programming and emulation code, Eagle 5.4.0, in order to implement the interconnections between
devices and and their positions on the board, and CircuitCAM 5.2, just to convert the files generated

by the previous software into a format understood by the cutter.

At the end of the monograph is expected to have in hand the design of a robust plate, which can meet
all requirements for their implementation, thus, all components have been studied and tested in proto-

board modules, and then build the project.

Even with all the care and study to completion of the project, improvements are proposed in the final
points, possible through new approaches to certain issues, by using different technologies, by the in-
crease of the availability of monetary resources or even the greatest time of dedication to the imple-

mentation.

Keywords: robot soccer, main board, robot, project, Eagle 5.4.0.
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INTRODUCAO

Esta monografia pretende apresentar o projeto completo de uma placa eletrdnica cuja finalidade é
realizar a movimentacdo de uma plataforma robotica, desde a andlise das caracteristicas dos compo-

nentes presentes na placa, passando pelo projeto da mesma até chegar em sua programagcao.

A motivacdo de tal trabalho surgiu no grupo de robética do Departamento de Engenharia Elétrica,
GEAR, tendo como objetivo desenvolver, aperfeicoar e aplicar o conhecimento aprendido em sala de

aula por meio da construgdo de um sistema autdbnomo de futebol de robds.

O sistema é composto basicamente de quatro areas, hardware, mecénica, visdo computacional e
inteligéncia artificial. Esse trabalho se restringe a mostrar o desenvolvimento da placa eletrénica, ele-

mento principal e vital da area de hardware.

Dessa maneira, 0 objetivo da monografia é concretizar o projeto de tal placa eletrénica, de forma
gque a mesma possua 0s requisitos exigidos pelo rob6 para a fungdo ao qual serd utilizado, além de

possibilitar que os leitores sejam capazes de entender seu funcionamento.

Todos os componentes da placa eletronica foram analisados minuciosamente desde suas caracte-
risticas elétricas, até a disponibilidade do mesmo no mercado. Os médulos da placa foram todos proje-
tados individualmente e testados em protoboard antes do projeto final ser concretizado, colaborando

dessa maneira para a corre¢ao de erros e integracdo desses modulos.

A programacdo foi modularizada 0 maximo possivel, gerando dessa maneira codigos mais exten-
sos, porém mais inteligiveis. Bibliotecas e estruturas foram desenvolvidas, facilitando dessa maneira a

correcao de erros e até a simulacdo do sistema.

As folhas de dados dos componentes além de manuais de referéncia do microcontrolador foram
essenciais para o desenvolvimento deste trabalho, ja que neles é possivel encontrar desde informacGes
a respeito do dispositivo, até circuitos e codigos de exemplo, tornando as explicagdes muito mais elu-

cidativas.
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1 OBJETIVOS

O presente trabalho foca a construcdo de uma placa eletrénica capaz de suprir as necessidades de
um robd, com excessdo de seu chute, para competicdes de futebol de rob6s na RoboCup categoria
Small Size, uma das mais tradicionais no ambito internacional, porém ainda pouco desenvolvida no
Brasil. [1]

O rob6 deve caber em um cilindro de 180 mm de didmetro, ndo podendo ultrapassar 150 mm de
altura, conforme exibido na Figura 1. Dessa maneira, as dimensfes da placa eletrbnica ficam limita-

das, tanto em raio quanto em altura. [2]

MAX 150 mm

Figura 1: Dimensdes Maximas do Jogador [2]

O jogador também deve ser capaz de conduzir uma bola de golfe laranja e executar jogadas com
ela, como chutes, passes e dribles, conforme exibido na Figura 2. Dessa maneira, uma segunda placa

deve ser projetada, denominada “Placa de Chute”, que esta fora do escopo deste trabalho.

O mecanismo responsavel pela condugdo da bola é chamado “Dribbler” ¢ tem como fungéo apli-
car um spin negativo a esfera, fazendo com que ela fique de posse do jogador enquanto esse se loco-

move pelo campo. [2]

15



See B0/20 rule
for details

erted backspin

Figura 2: Conducéo de Bola [2]

Dessa forma o desafio esta no projeto e construgdo de uma placa capaz de receber informages de
um computador, processa-las, executar os movimentos solicitados, de maneira controlada, permitir a

conducdo da bola e realizar a telemetria do sistema.

Todo o projeto das interligacBes entre componentes, denominado esquematico, foi feito com o
software Eagle 5.4.0, o mesmo utilizado para posicionar os componentes na placa e tragar as trilhas
gue os conectam, chamado de board.

O programa responsavel por converter o arquivo board, do Eagle, em uma extensdo compreensi-
vel pela fresa foi o CircuitCAM 5.2, onde as camadas superior, inferior, de furos e de bordas sdo aco-

pladas e exportadas em um arquivo com extensdo “.LMD”, como descrito no Anexo A.

O microcontrolador foi programado e a placa emulada por inteira, utilizando o MPLAB IDE da
Microchip e o gravador/emulador PICKIT 3.

16



2 ESTADO DAARTE

2.1 Hardware

Para que o rob6 possa executar as fungdes solicitadas, é vital que possua como um de seus princi-
pais modulos uma placa eletrdnica capaz de adquirir as informagfes enviadas, via radio frequéncia,
por uma placa de transmissdo conectada a um computador, processa-las e realizar o acionamento dos

motores.

A telemetria é de grande importancia a plataforma robdtica, uma vez que medigdes do nivel da
bateria, orientagdo do robd, posse de bola e tensdo presente nos capacitores de chute sdo importantes
para que a inteligéncia artificial tome melhores decisdes durante as partidas, justificando dessa manei-

ra a transmissdo de dados em ambos os sentidos.

Com base nestes argumentos, antes da execucao do projeto, é importante realizar a pesquisa € 0
estudo de componentes capazes de suprir as necessidades do rob6, possibilitando ao mesmo o desem-

penho exigido por tal aplicagéo, futebol de robos.

O presente trabalho divide a placa eletronica em trés grandes médulos: Comunicagéo, Proces-
samento de Dados e Acionamento dos Motores, que serdo abordados nos capitulos 2.2 , 2.3 e 2.4

respectivamente, baseando o projeto do sistema eletronico.

2.2  Comunicacéo

Como os robds necessitam de grande liberdade com relagéo a fios, para poderem jogar futebol o
tipo de comunicacdo utilizada entre eles e o computador fica limitada as formas de transmissdo de

dados que utilizam da tecnologia wireless, eliminando dessa maneira as cabeadas.

A comunicacdo wireless pode ser feita via radio frequéncia, micro-ondas ou infravermelho. [3]

No desafio em questdo, € interessante a utilizacdo da primeira tecnologia, visto que no mercado de
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produtos eletrdnicos brasileiro sdo encontrados dispositivos de pequeno porte capazes de realizar a

transmissdo de dados, a recepcdo deles ou até mesmo ambos em um Unico componente.

22.1 Transceptor

Transceiver, ou transceptor, é um dispositivo que possui tanto o sistema transmissor quanto o re-

ceptor, combinados no mesmo circuito ou no mesmo encapsulamento. [4]

O TRF-2.4G é composto de uma antena, um sintetizador de frequéncia integrado, um amplifica-

dor de poténcia, um cristal oscilador e um modulador. Consome baixa corrente e é programado utili-

zando uma interface de trés linhas. [5] A Figura 3 apresenta o transceptor, juntamente com a disposi-

cao de seus 10 pinos e suas dimensoes.

GND
CE .
CLK2 .

cs -
cLk1 -—

20.5mm

Smm

Smm

BOTTOM VIEW

|" 2.8mm

Surface and size view
10.25mm

N l ' s2mm [ TOP VIEW
arnm — &

SIED VIEW

Mote: The connector pitch size is 1.25mm, mounting hole diameter is 2 8mm

Figura 3: Transceptor TRF 2.4G [5]

A descricdo resumida de cada um dos pinos do dispositivo esta apresentada na Tabela 1, junta-

mente com sua nomenclatura.
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Tabela 1: Funcdes dos Pinos do Transceptor

Pinos e suas Fungbes

GND Terra

CLK2 Clock para RX do canal 2

CLK1 Clock para TX e RX do canal 1

DR1 Dados de RX prontos no canal 1

DR2 Dados de RX prontos no canal 2

Os valores minimos, tipicos e maximos dos parametros do dispositivo em questdo estdo apresen-
tados na Tabela 2, possibilitando assim realizar anélises a respeito da conexdo deste com outras inter-

faces.

Tabela 2: Caracteristicas Elétricas do Transceptor

Caracteristicas Elétricas

Ve 1,9v 3,0V 3,6V

Vi Vss - 0,3V

19



VoL Vss - 0,3V

fop 2.400MHz - 2.524MHz

2.2.2 Modo de Operacao

O dispositivo TRF-2.4G pode assumir os modos de operacdo presentes na Tabela 3, dependendo

do valor aplicado aos pinos CE e CS. [5]

Tabela 3: Modos de Operagéo [5]

Modos de Operacéo do Dispositivo TRF-2.4G

Modo CE CS
Ativo - RX/TX 1 0
Configuragéo 0 1
Espera 0 0

Quando ativo o transceptor pode operar em uma das duas configuragdes existentes, Modo Direto
ou ShockBurst™. [5]

A tecnologia ShockBurst utiliza o sistema FIFO on-chip, onde é gerada uma pilha sendo que as
instrugdes sdo processadas na ordem de chegada, para possibilitar a entrada de dados no transceiver,
em baixa taxa de transferéncia e transmiti-los, no ar, a uma altissima taxa, podendo atingir 1Mbps,
oferecido pela banda de 2.4GHz, sem a necessidade de um microcontrolador de alta velocidade para

tanto, além de reduzir consideravelmente o consumo de poténcia. [5]

A economia, tanto de processamento como de energia, ocorre porque o microcontrolador ap6s
configurar o Cl para operar no modo ShockBurst™ necessita enviar ao transceptor apenas o endereco e
0s dados que deseja transmitir, de forma que o TRF-2.4G se encarrega de gerar o CRC, realizar a a-
mostragem dos bits e codificar ou decodificar os pacotes, dependendo se serd realizada uma transmis-
séo ou recepcao. Em seguida o transceptor pode transmitir ou receber as informagdes a uma velocida-
de de até 1Mbps e dormir. [6]

A comunicacao entre o microcontrolador e 0 TRF-2.4G é feita por meio de uma interface de 3 li-
nhas, CS, CLK1 e DATA, de forma que a palavra de configuracdo, quando em modo ShockBurst,

habilita o transceptor a armazenar o protocolo RF. [5]
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Para a utilizagio do modo ShockBurst™ é necessario configurar:
e Tamanho do bloco de dados
e Tamanho do endereco
e Endereco de destino para dados recebidos
e CRC

Com tais dados armazenados nos registradores de configuracdo, quando for realizada uma trans-

missao, o pacote gerado sera do formato apresentado na Figura 4.

PRE-AMBLE ADDRESS PAYLOAD ‘ CRC

Figura 4: Estrutura do Pacote de Configuracao [5]

A transmissao de dados é feita da seguinte maneira: [5]
e Quando o MCU necessita enviar dados, o pino CE deve ser posto em nivel légico alto;
e O endereco do né de recebimento e os dados devem ser pulsados no TRF-2.4G;
e MCU coloca CE em nivel I6gico baixo, ativando a transmissdo ShockBurst;
e Preamble é adicionado e CRC é calculado, para completar o pacote;
o Dados sdo transmitidos em alta velocidade, 250kbps ou 1Mbps;
e O dispositivo TRF-2.4G retorna ao estado de espera quando a transmissao é concluida.

Como pode ser analisado na Figura 5 que contempla o fluxograma de tal operacao.
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TRF-2.4G
in ShockBurst

Data content of registers:

MCU Loading

ADDR & PAYLOAD
data ADDR PAYLOAD

TRF-24G
Calculating CRC ADDR PAYLOAD CRC

b4

S NO
CE=Low? >

=

YES

TRF-2.4G
Adding Preamble amablc ADDR PAYLOAD CRC

!

TRF-2.4G Sending
ShockBurst Package
( 250K or 1Mbps )

Input FIFO not Empty

Sending
completed?

Figura 5: Transmissdo de Dados Utilizando ShockBurst [5]
A recepcdo de dados é realizada da seguinte maneira: [5]

O endereco e 0 tamanho do payload dos pacotes RF de entrada sdo definidos assim que o TRF-
2.4G é configurado no modo ShockBurst;

e Para habilitar a recepcao, o pino CE deve ser colocado em estado logico 1;
e O dispositivo ird comegar a monitorar o ar buscando informagdes de entrada;

¢ Quando um pacote valido é encontrado, ou seja, endereco correto e encontra 0 CRC, o

dispositivo remove os bits de preamble, endereco e CRC, restando apenas a carga Util;

e O pino DR1 entdo é colocado em nivel légico alto, notificando o0 MCU por meio de uma

interrupcao externa;

e O MCU deve entdo colocar CE em nivel légico baixo;
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2.3

0 download dos dados.

TRF-2.4G
—»{ Detects Preamble &
Incoming Data

Data content of registers:

O MCU entdo retira apenas o payload a uma taxa aceitavel para o0 mesmo;

Como pode ser analisado na Figura 6 que contempla o fluxograma de tal operacao.

RF-
in ShockBurst

TRF-2.4G
Receives Data &
Checking CRC

TRF-24G
Set Data Ready
(DR1/2) High

l

MCU
Clock out Payload

RF-2.4G
Register

Empty?
\pt&”

TRF-2.4G

Set Data Ready
(DR1/2) Low

Figura 6: Recepc¢ao de Dados Utilizando ShockBurst [5]

Processamento de Dados

A ADDR PAYLOAD CRC
amd.e
ADDR PAYLOAD CRC
ADDR PAYLOAD CRC
ADDR PAYLOAD CRC
PAYLOAD
PAYLOAD
Output Register Empty

Quando todos os dados foram coletados DR1 é colocado em nivel 1dgico baixo novamen-

te e o dispositivo esta pronto para uma nova recep¢do caso o0 CE mantenha-se alto durante

Um microcontrolador é um sistema computacional completo, no qual estdo incluidos uma CPU

(Central Processor Unit), memoria de dados e programa, um sistema de clock, portas de 1/0O (In-
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put/Output), além de outros possiveis periféricos, tais como, médulos de temporizacdo e conversores
AJD entre outros, integrados em um mesmo componente. As partes integrantes de qualquer computa-

dor, e que também estdo presentes, em menor escala, nos microcontroladores sao:
e Unidade Central de Processamento (CPU)
e Sistema de clock para dar sequéncia as atividades da CPU
e Memoria para armazenamento de instrugdes e para manipulacao de dados
e Entradas para interiorizar na CPU informa¢des do mundo externo
e Saidas para exteriorizar informagdes processadas pela CPU para o mundo externo
e Programa (firmware) para definir um objetivo ao sistema
(DENARDIN, 2011)

O MCU ¢ interessante no ambito de centralizar as informagdes, atribuir tarefas aos periféricos e
gerenciar suas agoes, fazendo com que a plataforma robdtica torne-se confiavel e controlada, caracte-

risticas importantes em um sistema desse porte.

2.3.1 Caracteristicas Gerais

O MCU usado é o dsPIC33FJ256MC710A, que possui 100 pinos, podendo até 85 deles serem
utilizados como E/S, 8 saidas de PWM, com 4 geradores, 9 Timers de 16 bits e 32 canais de conversao
A/D gerenciados por 2 modulos, além de possuir taxas altas de processamento de dados podendo atin-
gir 40MIPS.

Os pinos, suas nomenclaturas e disposi¢do encontram-se na Figura 7.
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Figura 7: Pinos dsPIC33FJ [8]

Os pinos preenchidos de preto na Figura 7 sdo capazes de receber tensdes de até 5V e fornecer
tensoes tipicas de 3,3V, ao passo que os preenchidos de branco, tanto fornecem quanto recebem tipi-

camente 3,3V.

As principais caracteristicas elétricas do dispositivo, juntamente com seus valores minimos, tipi-

cos e maximos, encontram-se na Tabela 4.
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Tabela 4: Caracteristicas Elétricas dsPIC33FJ

Caracteristicas Elétricas

Parémetro Minimo  Tipico = Méaximo

Tensdo VDD -0,3V 3,3V 4,0V
Corrente de Saida do VSS - - 300mA
Corrente de Entrada no VDD - - 250mA

Corrente fornecida por qualquer pino 1/O - - 4mA

Corrente drenada por qualquer pino 1/0 - - 4mA
Corrente fornecida por todas as portas - - 200mA
Corrente drenada por todas as portas - - 200mA

2.3.2 Modo de Operacao

O dispositivo dsPIC33FJ256MC710A trata-se de um microcontrolador, dessa forma, possui di-
versos maddulos integrados em seu encapsulamento, bastando configura-los de maneira correta para

obter o funcionamento esperado desses.

Nos topicos seguintes maiores explicagdes serdo dadas a respeito do funcionamento de cada peri-

férico relevante para a realizagdo do projeto da plataforma robdtica.

2.3.2.1 In-Circuit Serial Programming™

Os pinos PGECx e PGEDx sdo utilizados para realizar a In-Circuit Serial Programming™,
ICSP™, além do In-Circuit Debugger, que sera abordado na secfo 2.3.2.2 . Para que o procedimento
ICSP™ seja realizado com sucesso, também é necessério realizar as conexdes dos pinos Vss, Vpp €

MCLR, sendo a linha de sequéncia de programacéo opcional. [8]

Para permtir ao projetista maior flexibilidade durante o projeto do hardware, o Cl viabiliza a pos-

sibilidade da utilizacdo de um dos trés pares de linhas para clock e dados, denominados: [8]

e PGEC1 e PGEDL, pinos 26 e 27, respectivamente;
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o PGEC2 e PGED2, pinos, 74 e 73, respectivamente;

e PGEC3 e PGEDS3, pinos 24 e 25, respectivamente.

2.3.2.2 In-Circuit Debugger

A tecnologia In-Circuit Debugger permite que o programador realize a emulagéo do MCU, sendo
que as entradas sdo processadas fisicamente para entdo fornecer as saidas, diferentemente das simula-
¢Oes, onde um programa analisa as entradas para entdo fornecer as saidas. Dessa maneira, caso alguma
particularidade de hardware ndo seja programada no simulador, este nao iré retornar saidas tdo confi-

aveis quanto as obtidas pela emulacéo.

Para utilizar essa tecnologia é necessario realizar as conexdes dos pinos PGECx, PGEDX, Vss,
Vpp € MCLR, assim como no processo de ICSP™. Também deve ser informado que certos gravadores
sdo capazes de executar apenas a programagdo do MCU, portanto, para que seja possivel o In-Circuit
Debbuger é necessério adquirir um gravador/emulador, como o PICKIT3 ou 0 MPLAB® ICD 2. [8]

O software MPLAB IDE gerencia tanto o processo de programacao do microcontrolador quanto o
de emulacéo dele, sendo esse Ultimo, vital para a verificagdo do funcionamento das fungdes programa-

das no chip e correcéo de erros.

Assim como na tecnologia ICSP, a In-Circuit Debugger permite que o projetista escolha qual dos
trés pares, PGECx e PGEDX, sera utilizado. [8]

2.3.2.3 Configuration Bits

Os bits de configuracdo podem ser programados ou deixados sem programacdo (lidos como nivel
alto), gerando dessa forma, diversas configuracdes para o dispositivo. Tais bits sdo mapeados come-

cando da posi¢do 0xF80000 da meméria de programa. [8]

Os registradores presentes nessa estrutura definem condicGes basicas de como o MCU ira operar
durante a execuc¢do do cddigo presente neste. O mapeamento de tais registradores esta apresentado na

Figura 8.
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Address | Name Bit 7 Bit 6 Bit5 Bit4 Bit 3 Bit 2 | Bit1 | Bit0
0xF30000 | FBS RBS<1:0> = == BSS<2:0> BWRP
0xFB0002 | FSS RSS<1:0> — = 555<2:0> SWRP
0xF30004 |FGS = = == = = GSS1 | GSSO | GWRP
0xF80006 |FOSCSEL | IESO |Reserved? — = = FNOSC<2:0>
0xF80008 | FOSC FCKSM<1:0> = = — |oscioFnc | PoscMD<1:0>
0xF3000A | FWDT FWDTEN | WINDIS — |woTePRE WDTPOST<3:0>
0xF8000C | FPOR PWMPIN | HPOL LPOL = =3 FPWRT<2:0>
0xF8000E | FICD Reserved!') JTAGEN = = — | ics<to>
0xF80010 | FUIDO User Unit ID Byte 0

0xF80012 | FUID1 User Unit ID Byte 1

0xF80014 | FUID2 User Unit ID Byte 2

0xF80016 | FUID3 User Unit ID Byte 3

Figura 8: Mapeamento dos Registradores de Configuracao [8]

Como pode ser observado na Figura 8, o microcontrolador possui tal estrutura distribuida em 12
registradores de configuracéo, sendo eles FBS, FSS, FGS, FOSCSEL, FOSC, FWDT, FPOR, FICD,
FUIDO, FUID1, FUID2 e FUID3. Cada um desses divididos em estruturas menores, ao nivel de bits,

possibilitando diversas configuracdes distintas do dispositivo.

Para prevenir mudancas indevidas nos bits de configuragdo durante a execucao do programa, tais

bits séo escritos uma Unica vez a cada energizacdo do dispositivo, ou seja, para alterar o valor de tais

bits é necessario desenergizar o dispositivo e energiza-lo novamente. [9]

Tabela 5: Registradores de Configuracdo Geral

Registradores de Configuracéo Geral do Microcontrolador

Registrador

FOSCSEL

FBS

FSS

FGS

FOSC

FWDT

FPOR

FICD

Descricéo

Protecéo de escrita no segmento de boot

Protecdo de escrita no segmento de seguranca

Protecdo de escrita no segmento geral

Selecdo do oscilador

Configuracéo do oscilador

Configuracdo do Watchdog Timer

Configurac6es iniciais do PWM

Configuracdo de emulagédo
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2324 Oscilador
O dispositivo oferece varias fontes de clock, tanto internas ao chip quanto externas: [8]
e Oscilador FRC
e Oscilador FRC com PLL
e Oscilador Priméario (XT, HS ou EC)
e Oscilador Primario com PLL
e Oscilador Secundério (LP)
e Oscilador LPRC
e Oscilador FRC com Postscaler

O oscilador FRC com PLL foi o escolhido para o projeto, pois, ndo necessita de circuitos exter-
nos, além de permitir que o0 MCU opere com 40MIPS. O oscilador interno, FRC, possui frequéncia
nominal igual a 7,37MHz. Tal frequéncia, denominada Fosc € divida por dois para gerar o clock de
instrucdo do dispositivo, denominado Fcy. [10]

FOSC

Fry =
cY 2

O dsPIC33FJ256MC710A é capaz de, utilizando seu oscilador FRC juntamente com a tecnologia
de PLL, atingir sua Fcy maxima de 40MIPS, caracteristica interessante, pois simplifica o hardware, ja

que nesse caso 0S cristais somente serdo necessarios quando a aplicagdo exigir grande precisdo de

temporizagéo.

A Figura 9 exibe o diagrama de blocos do funcionamento do PLL, juntamente com as frequéncias
minimas e maximas aceitas em cada ponto do sistema, tais valores devem ser respeitados para a corre-

ta temporizacdo do MCU.
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Figura 9: Diagrama de Blocos do PLL [10]
A deducdo da formula que relaciona FIN com FOSC esta apresentada na Figura 10, na qual PLL-

PRE, PLLPOST e PLLDIV sdo registradores.

M
N1 x N2

) = Fovx ELEDIF+ ) )

FosC = FINx |
% \(PLLPRE+2) x 2(PLLPOST+ 1)/

Where:

N1=PLLPRE +2

N2 =2 x (PLLPOST +1)
M=PLLDIV + 2

Figura 10: Calculo de Fosc [10]

2.3.25 Portas 1/0

Os pinos do dispositivo, com exce¢do do Vpp, Vss, MCLR, e OSC1/CLKIN, s&o compartilhados
entre periféricos e portas paralelas de 1/0. Tais portas s&o todas providas de uma configuracdo Schimitt

Trigger garantindo, dessa maneira, melhorias na imunidade ao ruido. [11]

Quando um periférico, associado a um pino, é habilitado, o uso para propdsitos gerais de tal pino
é desabilitado. Todos os pinos possuem trés registradores diretamente relacionados as operagdes de

entrada e de saida digital. [8]

O registrado TRISx determina a dire¢do do fluxo de dados, de tal forma que quando ao bit é atri-
buido o valor “1”, o pino controlado pelo mesmo passa a comportar-se COmo um pino de entrada, ao
passo que caso o valor seja “0”, 0 pino sera reconhecido como saida de dados. Ap6s a acdo do Reset,

todos os pinos sdo definidos como entradas digitais. [8]

Os registradores LATx e PORTx sdo utilizados para a manipulacdo dos bits, de tal forma que, ler

pelo LATX realiza uma leitura no latch e realizar a escrita no registrador LATX, escreve no latch, ao
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passo que ler do registrador PORTX |€ o bit presente na porta e escrever no PORTx escreve no latch.
(8l

Na Figura 11 esté exibida uma estrutura exclusivamente de entrada e saida, sem considerar o peri-
férico, de forma que em tal imagem fica clara as diferengas acima explicadas a respeito da leitura nos
registradores LATx e PORTx. [11]

Dedicated Port Module

FRrTalir =T N B T i dETTeaT iR = T
I Read TRIS | /O Cell
| %I | ey
| l N |
| DataBus— ¢ (D Q || |
| ’_l_l_{ |
WR TRIS— K
| gy || |
TRIS Latch |
< |
| D al ] /O pin|
| |
WR LAT —1— | |
| WRPORT—‘%)__& | B meqnesseced
| Data Latch |
| ,_ﬂ | ||
| Read LAT ____| 7™ |
| |
| |

Read Port j

Figura 11: Estrutura exemplo de um pino 1/0 [11]

2.3.2.6 Timers

O microcontrolador possui nove timers, sendo que todos podem ser configurados para funcionar
como temporizadores ou contadores. O timer 1, tipo A, é independente dos demais, ja os Timers 2, 4, 6
e 8, tipo B, podem ser associados aos Timers 3, 5, 7 e 9, tipo C, respectivamente, para formar tempori-
zadores de 32 bits, ja que individualmente, os mesmos possuem 16 bits para realizar a temporizag&o.
[12]

Quando o interesse é a configuracdo de contadores, o dispositivo pode prover até cinco dos mes-
mos, ja que os Timers 2 e 7 compartilham do mesmo pino, assim como os Timers 3e6,4e9e5e 8,

como pode ser observado na Figura 7. [12]
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Tal periférico € muito importante, j& que permite a contagem de tempo ou até mesmo de pulsos
externos, sem interferir na execucdo do programa principal, garantindo dessa maneira exatiddo na

temporizacdo e contagem.

Os timers 6, 7, 8 e 9 foram configurados como contadores externos, ao passo que os timers 3 e 5
como temporizadores. Tais configuragdes séo implementadas com base nos registradores apresentados

na Tabela 6.
Tabela 6: Configuracdo dos Timers
Registradores de Configuracédo dos Timers
Registrador Descrigéo
TXCON (para x=1, tipo A) Registrador de configuracdo do Timer tipo A
TXCON (para x=2, 4, 6, 8) Registradores de configuracdo dos Timers tipo B
TXCON (para x=3,5,7,9) Registradores de configuragdo dos Timers tipo C
2.3.2.7 PWM

A modulagéo por largura de pulsos pode ser utilizada em aplicacdes de telecomunicacdes, regula-
cao de tensdo, efeitos de audio, ou, como nesse caso, na transferéncia de poténcia. Tal técnica é muito
vantajosa, pois a transferéncia de poténcia a carga acontece sem as consideraveis perdas ocorridas

devido a queda de tenséo por recursos resistivos. [13]

O chaveamento é feito por transistores que ora estdo funcionando como chaves fechadas, permi-
tindo a passagem total de corrente e ora bloqueiam a passagem da mesma, funcionando como chaves
abertas, porém como tal chaveamento é feito em alta frequéncia, a estimulacéo sentida pelo motor DC,
carga, € a média entre o tempo em que o transistor conduziu e bloqueou a passagem de corrente. Tal
relacdo é conhecida por duty cycle do inglés, ou, razdo ciclica, do portugués, e é dada pela seguinte

equacdo 1: [13]

TbN

Duty Cycle = T (D

TOTAL

O mddulo PWM presente no MCU simplifica a tarefa de gerar maltiplas saidas sincronizadas,

moduladas por largura de pulsos, ja que tal periférico possui em hardware quatro geradores de duty
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cicle independentes, numerados de 1 a 4, além de oito saidas, comandadas por seus respectivos gera-
dores de razdo ciclica, porém subdivididas em dois grupos, High (H) e Low (L). [14]

O periférico em questdo pode funcionar de diversas maneiras e em varias aplicacfes, para tanto o
mesmo é configurado por meio da programacdo de seus registradores. Esses, juntamente com suas

funcdes estdo apresentados, de maneira resumida, na Tabela 7.

Tabela 7: Registradores do PWM

Registradores de Configuracao do médulo PWM

Registrador Descrigdo
PXxTCON Registrador de controle da base de tempo do PWM
PXTMR Registrador do valor de contagem de tempo do PWM
PXTPER Registrador do periodo da base de tempo do PWM
PXSECMP Registrador de comparagéo de evento especial
PWMxCON1 Registrador de controle do PWM 1
PWMxCON2 Registrador de controle do PWM 2
PxDTCON1 Registrador de controle do tempo de término 1
PxDTCON2 Registrador de controle do tempo de término 2
PXFLTACON Configurac@es relacionadas a falhas ocorridas nos PWMs.
PxFLTBCON Configurac@es relacionadas a falhas ocorridas nos PWMs.
PxOVDCON Utilizado para controle da sobreposicdo das saidas dos PWMs.
PxDC1 O valor da razdo ciclica das duas saidas do PWM 1 é escrito nesse registrador.
PxDC2 O valor da razéo ciclica das duas saidas do PWM 2 é escrito nesse registrador.
PxDC3 O valor da razdo ciclica das duas saidas do PWM 3 é escrito nesse registrador.
PxDC4 O valor da razo ciclica das duas saidas do PWM 4 é escrito nesse registrador.
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2.4 Acionamento dos Motores

O motor escolhido foi o “Série 2342 012 CR” da fabricante Faulhaber, por possuir tensdo nomi-
nal igual & 12V, a qual é compativel com a bateria, poténcia de saida de 17W e constante de velocida-
de de 713rpm/V, além de suportar correntes de até 1,4A. [15] Os componentes do circuito de aciona-

mento sdo listados nos subitens seguintes.

24.1 Ponte H

Tal dispositivo eletrénico tem como funcéo principal possibilitar o acionamento de motores em
ambos os sentidos, fornecendo a poténcia exigida por eles, ja que tais mecanismos necessitam de am-
plitudes de correntes e de tensGes as quais um MCU convencional ndo consegue suprir. O Cl L298
possui 15 pinos organizados, como exibido na Figura 12, e um encapsulamento denominado Multi-
wattl5.

Figura 12: Circuito Integrado L298 [16]

24.1.1 Caracteristicas Gerais

O dispositivo L298 € um circuito monolitico integrado com encapsulamento Multiwatt de 15 pi-
nos, composto por duas pontes H completas, permitindo dessa forma o acionamento de até dois moto-

res DC para ambos os lados, independentemente. [16]
Na Tabela 8 estdo exibidas as caracteristicas elétricas relevantes do CI.

Tabela 8: Caracteristicas Elétricas do ClI L298 [16]

Caracteristicas Elétricas

Parametro Minimo  Tipico = Maximo

Tens&o de Alimentagéo (VS) 2,5V - 46V
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Tensdo de Alimentacgéo Logica (Vss) 4,5V 5V 1A

Estado Ldgico Baixo de Entrada -0,3vV - 1,5v
(Vi)
Estado Ldgico Alta de Entrada (Viy) 2,3V - Vss
Estado Ldgico Baixo de Habilitacdo -0,3V - 1,5v
(Vent)
Estado Logico Alto de Habilitacio 2,3V - Vss
(Venn)
Poténcia Maxima Dissipada - 25W -
Frequéncia de Comutacéo - 25kHz 40kHz

Para melhor analise do dispositivo, a Figura 13 mostra seu diagrama de blocos, onde podem ser
feitas observacgdes a respeito da habilitacdo da base dos transistores BJTs por meio das portas I6gicas
conectadas as mesmas, além do sentido do fluxo de corrente pelos ramos das pontes-H.

+
ouTi ourz ¥s wonf  OUT3 outé.

2 3 & 3 16

+os | g

o e A B
I3 . |

100nF
1 2 3 %
1 ._>_L_r—4
2 |, o | M
Ena EnB
3 [ " -0
1 8 15

Figura 13 - Diagrama de Blocos do CI L298 [16]

Para filtrar os ruidos fazem-se necessarios dois capacitores de 100nF, um conectado ao Vss € ou-
tro conectado ao Vs, ambos realizando a ligacdo entre tais pinos e 0 GND. Também sdo indispensaveis
dois resistores de poténcia Rsa € Rsg, para que possa ser medida a corrente que flui pelos motores co-

nectados ao ramo A e ao ramo B. [16]
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Para evitar danos aos transistores BJTs presentes no Cl, diodos de rapida recuperagdao devem ser
conectados como mostrado na Figura 14. Esses diodos tém a fungéo de descarregar a corrente residual
na bateria que alimenta o circuito, tal corrente surge pelo fato do motor possuir impedancias relevan-
tes. [16]

Figura 14: Diodos de Protegéo

O manual do CI recomenda a utilizacdo de diodos com tempo de recuperagdo inferior & 200ns.
[16]

24.2 Encoders

Acoplado a parte traseira de cada motor da Faulhaber esta o dispositivo denominado encoder 6p-
tico. Tal dispositivo é provido de dois canais, permitindo dessa forma analisar qual o sentido de rota-
¢ao do motor, 512 linhas por volta, tensdo de alimentacdo podendo variar de 4V a 18V e corrente mé-

xima admitida igual a 15mA. [17]

Para melhorar o tempo de subida do pulso enviado pelo encoder, um resistor externo de pull-up
pode ser adicionado ao circuito, como exibido na Figura 15, porém deve-se atentar & limitagdo de cor-
rente de 15mA. [17]
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Figura 15: Resistor de Pull-Up [17]

O método para determinar o sentido de rotacdo do motor apesar de simples, ndo serd explicado
nesse trabalho, ja que o controle aplicado a tais motores é apenas de velocidade, ndo interessando des-

sa maneira se 0 mesmo esta funcionando no sentido horario ou anti-horério.

Na Figura 16 esta exibida a disposi¢cdo dos pinos do motor, porém como nesse caso 0 motor su-
porta correntes superiores a 1A, atingindo até 1,4A, os pinos 1 e 2 estdo presentes em um conector
separado. [17]

Pin Function

1 Motor-*
2 Motor +*
3 GND
4 Vpp
5 channel B
6 channel A

PVC-Ribbon cable
6 conductors 0,09 mm?

*Note: The terminal resistance
of all motors with precious
metal commutation is increased
by approx. 0.4 ©, and the max.
allowable motor current in
combination is 1A. Motors with
graphite commutation and
brushless motors have separate
motor leads and higher motor
current is allowed.

Figura 16: Disposi¢éo dos Pinos do Motor Faulhaber [17]

2421 Modo de Funcionamento

De maneira simplificada, o encoder éptico é composto por um ou mais LEDs emissores de luz a-
Iém de um ou mais fotorreceptores e um disco, acoplado ao eixo de rotacdo do motor, com frestas que

permitam a passagem de luz. Tal construcdo esta exibida na Figura 17.
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Figura 17: Estrutura do Encoder Optico

Conforme o eixo do motor gira, pulsos quadrados séo obtidos na saida digital. Tais pulsos devem
entdo ser enviados a um sistema capaz de realizar o tipo de controle adequado. Para a aplicacdo em

guestdo apenas o controle de velocidade faz-se necessario.



3 MATERIAIS E METODOS

A placa eletronica do robd, desenvolvida neste trabalho, tem por funcdo fazer a aquisi¢do dos da-
dos transmitidos por um computador, via RF, converté-los em sinais elétricos, que sdo processados por
um elemento central e enviados aos respectivos periféricos, garantindo a correta execucdo dos movi-

mentos solicitados pelo PC ao robd.

Tal placa pode ser dividida em trés partes principais, sendo elas, acionamento e controle dos mo-

tores, comunicagdo RF e processamento digital, que serdo detalhadas nas se¢des subsequentes.

A placa eletrnica possui dois médulos transceptores de alta frequéncia TRF-2.4G, permitindo
assim a telemetria da plataforma robotica, sendo que um dos dispositivos RF apenas recebe as infor-

mag0es passadas pelo computador e o outro transmite dados pertinentes do mesmo.

3.1  Comunicacio

Como o projeto prevé que a plataforma robdtica deve tanto receber quanto transmitir informagoes
ao computador, para facilitar a programacao do dispositivo foram utilizados dois mddulos transcepto-
res, quando apenas um, desde que programado de forma otimizada, seria capaz de suportar a carga de

dados.

Ao observar a Figura 3, apresentada no tdpico 2.2.1 , nota-se que a disposicéo dos 10 pinos do
dispositivo ndo favorece sua utilizacdo. Dessa maneira o dispositivo foi adquirido com uma placa de
adaptacdo de tais pinos para pin header de 1x10, como pode ser observado na Figura 18, destacado

com um retangulo vermelho.

Figura 18: Adaptador do Transceiver

Na Figura 19 esta exibido o esquematico de conexdo dos dois modulos transceptores. Tal projeto

é relativamente simples, uma vez que as tensdes utilizadas pelo TRF-2.4G e pelo MCU sdo compati-

39



veis, porém deve-se notar que, como é utilizada uma placa de conversdo dos pinos para o layout de pin

header 1x10, o posicionamento deles é alterado.

A000OOBO00

AO00OO0000

Figura 19: Projeto dos Transceivers

No projeto foi utilizado apenas o canal 1 para realizar a comunicagdo tanto TX como RX. A dife-
renca entre 0 médulo receptor e o transmissor esta no fato do médulo de recepgdo possuir o pino de-
nominado RX_DR1 conectado ao pino de interrupgédo externa do MCU, INTO.

Foi utilizada a tecnologia de ShockBurst™ para realizar a comunicacéo, exigindo menor proces-
samento de dados do microcontrolador, ja que esse fica encarregado de programar os registradores do

transceiver uma Unica vez, sendo necessario entdo apenas transferir e receber o payload desse.

3.2 Processamento de Dados

Todas as informag0es da placa eletrénica séo centralizadas no microcontrolador presente nela, pa-
ra entdo serem analisadas e, de acordo com a programagao do dispositivo, gerarem agles que serdo

executadas pelo robd.

O MCU selecionado para realizar o processamento dos dados do rob6 foi o ds-

PIC33FJ256MC710A da fabricante Microchip.

O manual do dispositivo recomenda conexdes minimas de capacitores e resistores ao MCU, para

que o mesmo funcione de maneira correta. Esta configuragdo esta presente na Figura 20. [8]
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Figura 20: Conexdes Minimas Recomendadas [8]

Como o dispositivo comprado ja apresentava tais conexdes em sua estrutura, ndo foi necessario
inclui-las no projeto, simplificando-o. Dessa maneira bastou realizar as interligaces entre o ds-
PIC33FJ256MC710A e seus periféricos, como exibido na Figura 21.
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Figura 21: Esquematico dsPIC33FJ

Como tal CI ndo existia na versdo do Eagle 5.4.0, e ndo foram encontradas versdes satisfatorias

para download, foi necessario o desenvolvimento de uma biblioteca para 0 mesmo.

3.3 Acionamento dos Motores

O roh6 é provido de cinco motores, sendo quatro deles para movimentacdo do sistema completo e

um para fornecer torque ao mecanismo auxiliar.

Baseado nos dispositivos apresentados nos itens 2.4.1 e 2.4.2 , considerando também suas cara
cteristicas elétricas e modo de funcionamento, foi gerado o seguinte esquematico para possibilitar o

acionamento e o controle de tais motores.

Tal esquemaético, construido utilizando o software Eagle 5.4.0, esté apresentado na Figura 22.
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Figura 22: Esquemético do Sistema de Acionamento e Controle dos Motores

Na Figura 22, para melhor visualizacdo, est4 apresentado apenas o esquematico de acionamento

de dois motores, sendo que o esquematico completo contempla o acionamento de quatro motores.

331 Modo de Operagéo

O circuito de acionamento de motores DC funciona como exibido na Figura 23.
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Figura 23: Operacéao do CI L298

Conforme pode ser observado na Figura 23 enquanto o pino de habilitagdo fica em estado l6gico
baixo, o motor fica livre, ao passo que quando tal pino esta em estado l6gico alto, existem trés possibi-
lidades, sendo elas compostas pelo giro do motor em um sentido, no sentido contrario e travado, quan-

do as duas entradas assumem o mesmo nivel ldgico.

Foi utilizado o método de modulacdo em pulsos (PWM) para setar as velocidades desejadas nos
motores, a frequéncia utilizada para tanto foi de 25kHz, como aconselhado no manual do dispositivo.

Inicialmente esses sinais foram pulsados no pino de habilitacéo, pois dessa forma apenas um pino
precisava mudar de estado para aplicar a velocidade desejada ao motor, porém ao levantar a curva de
Velocidade x Tensdo, foi verificado que a mesma era complexa, ao passo que quando o pino pulsado
era uma das entradas, tal relacdo tornava-se linear, facilitando o célculo do duty cicle do PWM de

forma que se conseguisse a velocidade desejada.

Uma grande desvantagem de utilizar o PWM nos pinos de entrada é que sdo necessarios dois
PWMs por motor para que 0 mesmo possa girar em ambos 0s sentidos, ao passo que utilizando o pino
de habilitacdo é necessario apenas um PWM para executar a mesma fun¢do. Como o MCU seleciona-
do é provido de oito PWMs e 0 projeto prevé quatro motores, optou-se pela utilizacdo dos PWMs nos

pinos de entrada e utilizacdo da curva Velocidade x Tensdo linear.

As equac0es 2 e 3 mostram como é calculado o valor que sera inserido em cada um do registrado-
res de duty cicle, utilizando como parédmetro a velocidade que deseja em cada roda do robé, levando
em consideracdo a caixa de reducdo utilizada, a tensdo da bateria, obtida por um conversor A/D e a

gueda de tensdo aproximada nos BJTs do Cl L298 de 1,6V.

Velocidadegoqq X 60 X Caixagequcio

(2)

Tensaogotacio =
otagdo 2 X m X Constantegotqeao
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PWMDC _ TenSéoRotagéo X PWMMéximo

(3)

Tensaoggteria — 1,6

3.3.2 Funcionamento do Acionamento e Controle dos Motores

O valor do duty cicle obtido para cada motor é programado em seus respectivos registradores de
PWM. Tais PWMs fornecerdo os pulsos considerando frequéncia estabelecida, tempo de trabalho e
sentido de rotacéo, aspectos esses informados pelo MCU.

Essas saidas sdo aplicadas as entradas das duas pontes-H presentes nos circuitos, fazendo com
que as mesmas fornecam a tensdo média dos pulsos em suas entradas aos motores e a corrente exigida

por eles, desde que nédo ultrapasse o valor de 1,4A, como recomendado no manual.

O monitoramento da corrente é realizado por meio do pino denominado Sense, fornecido na pon-
te-H, sendo que a corrente que flui pelo motor, também passa por esse pino e pelo resistor de poténcia
conectado entre tal ponto e 0 GND, possibilitando dessa forma, a leitura da queda de tensdo em cima

do mesmo e consequentemente a obtengdo do valor da corrente de entrada.

Como o piso por onde o robd navega geralmente possui irregularidades e diferentes resisténcias
de contato além de variagdes nos valores tipicos dos componentes, a velocidade determinada pelo
MCU difere daquela a qual o motor esta realmente funcionando. Para tanto o encoder 6ptico acoplado
ao mesmo, fornece ao microcontrolador a velocidade no eixo de saida do motor, realimentando o cir-
cuito e possibilitando o ajuste de sua velocidade, por meio de algum algoritimo de controle, como o P,
Pl ou PID.

3.3.3 Motor Auxiliar

Foi realizada uma andlise parcial para a determinacdo de tal motor, ja que tem como finalidade

apenas manter a bola do jogo presa ao rob6 por meio de um dispositivo chamado dribbler.

Dessa maneira foram utilizados motores que estavam no laboratério, porém nao possuiam nime-
ros de referéncias, consequentemente nao foi possivel encontrar os manuais dos mesmos, apenas sabe-
se gue tais motores aceitam as tensdes de 12V aplicadas a eles. Com isso um simples esquematico foi

projetado para realizar o acionamento desses mecanismos. Tal projeto encontra-se na Figura 24.
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Figura 24: Esquematico Dribbler

O resistor R37, com valor de 1k€ tem como objetivo limitar a corrente que entra na base do BJT
Darlington TIP 122. O diodo D17 1N4004 realiza a prote¢do do TIP 122, jogando a corrente residual

do motor de volta no mesmo.

34 Médulos Adicionais

34.1 DIP Switch

A placa eletronica é provida de um conector DIP Switch de 5 chaves, sendo as chaves 1, 2 e 3
responsaveis por informar ao MCU o numero do robd, aceitando dessa maneira até 8 numeragdes dis-
tintas. A chave 4 é responsavel por selecionar uma das duas frequéncias de transmissdo de dados e,
finalmente, a chave 5 é responsavel por selecionar uma das duas frequéncias da recepcdo de dados. A
posicdo das chaves deve ser ajustada antes de ligar o robd, ja que o MCU utilizara tal disposicdo para

realizar as configurag@es iniciais. A Figura 25 mostra o esquematico de tal bloco.
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Figura 25: Esquemético DIP Switch

3.4.2 Reset

O microcontrolador, segundo seu manual, € reiniciado quando a tensdo em seu pino 13, denomi-
nado de Master Clear, é posta em nivel légico baixo. Esse funcionamento pode ser verificado por

meio do esquematico da Figura 26.

i
o — ___ﬂ:'
V4

AV

Figura 26: Esquematico Reset

Pode-se observar que ao pressionar o push botton, o nivel légico presente no pino MCLR seréa ze-
ro, essa tensao sera mantida em nivel l6gico baixo por um curto periodo de tempo devido ao capacitor

C9, garantindo assim o tempo minimo para executar o reset do dispositivo.

Faz-se necessaria a utilizacdo de um jumper no circuito, pois ao realizar o processo de gravacao
do MCU, tensBes da ordem de 12V podem ser aplicadas ao pino MCLR pelo Vpp, podendo danificar
outros Cls presentes na placa. Com a insercdo do jumper a isolacédo fisica do sistema é concretizada,

fornecendo mais seguranca a ele.
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3.4.3 ICSP

Como j& explicado no capitulo que trata do microcontrolador presente no projeto, tal dispositivo
permite a sua programagao sem ser necessaria a retirada do mesmo do circuito, porém, como podem
surgir tensdes da ordem de 12V ao realizar a programacéo de MCU em circuitos, € necessario prover

protecdes aos periféricos, que podem ndo suportar tensdes de tamanha magnitude.

Para tanto foi incluido o jumper chamado de JP8 no esquematico, como pode ser observado no
capitulo 3.4.2 , e 0 esquematico presente na Figura 27 foi projetado para permitir a realizacdo do ICSP

de maneira correta.

000000

Figura 27: ICSP Esquemético

O MCU, como j& dito anteriormente, permite a utilizagdo do Debug on Chip, porém o gravador
do mesmo, PICKIT 3, ndo consegue fornecer correntes superiores a 0,5A e para tanto foi interessante
colocar o pino 2 do gravador com a saida de 3,3V fornecida pelo regulador de tensdo UA78M33CKC.
Dessa maneira o circuito consegue ser emulado completamente, pois as correntes exigidas pelo mesmo

conseguem ser fornecidas pelo CI.

34.4 Reguladores

Para garantir de maneira precisa as tensfes de alimentacdo dos Cls presentes na placa eletronica
foi necessaria a utilizacdo de dois reguladores de tensdo, sendo um com 5V de tensdo de saida e 0

outro com 3,3V de saida.

Segue apresentado na Figura 28 o esquematico dos reguladores de tens&o.
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Figura 28: Esquematico Reguladores de Tenséo

Nota-se uma singela diferenca entre os dois reguladores de tensdo. O primeiro, de 3,3V, néo ne-
cessita de capacitores, pois trata-se de um dispositivo construido para possuir muita precisdo em sua

tensdo de saida, caracteristica exigida pelo dispositivo que sera alimentado pelo MCU.

O segundo regulador de tensdo, com saida projetada para 5V, necessita do capacitor de saida para
garantir maior precisdo na mesma, ja que trata-se de um dispositivo com menor complexidade, se
comparado ao anterior, porém os dispositivos alimentados por ele ndo sdo tdo sensiveis como o micro-

controlador utilizado nesse projeto.

345 LEDs

Com o intuito de possibilitar uma analise bésica e rdpida do funcionamento de alguns sistemas da
placa de hardware, cinco LEDs foram adicionados a ela. O primeiro acende quando a tenséo da bate-
ria atinge um valor proximo ao limite, o segundo trata do funcionamento do MCU, o terceiro entra em
acdo sempre que a tensdo de 3,3V esta presente, o quarto e o quinto LED piscam quando o robd esta

transmitindo ou recebendo informacdes, respectivamente.

A Figura 29 mostra o esquematico do sistema de debug visual.
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Figura 29: Esquematico LEDs

Como o MCU utilizado ndo deve fornecer correntes maiores que 4 mA por pino, foi necessario
utilizar o Cl MC14066, dispositivo aqui chamado de LED Switch, que é capaz de fornecer as correntes
necessarias para o acionamento dos LEDs, tais correntes podem variar tipicamente entre 20 mA e 35
mA.

3.4.6 Sensor de Presenca

Como a aplicagdo principal de tal robd é jogar futebol, faz-se necessario a utilizagdo de um sensor

de presenga, para detectar quando 0 mesmo esta de posse da bola.

Para realizar a detecgdo de objetos com o sensor, utilizou-se um conjunto formado por um LED

ultra-violeta e um fotodiodo, acionado quando a luz ultra-violeta entra em contato com sua base.

O projeto deste sistema encontra-se na Figura 30.
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Figura 30: Esquematico do Sensor de Presenca

3.4.7 Bateria

Para realizar a alimentacdo dos robds foram utilizadas baterias de Lithium lon de 2.200 mAh com
quatro células ligadas em paralelo, gerando tensdo nominal de 14,8V, ja que cada célula possui tensdo

nominal igual a 3,7V.

Trés caracteristicas interessantes de tais baterias sdo que as mesmas ndo apresentam efeito de
memoria presente em tantas outras, possuem boa autonomia e sua tensdo fica bem estavel durante
grande parte do tempo de utilizacdo da mesma, como pode ser observado na Figura 31, que exibe a

curva de descarga de apenas uma célula de Lithium lon.

51



450

ILLUSTRATION OF TYPICAL
4.25 DISCHARGE CURVE AT
FIXED TEMPERATURE AND
4.00 DISCHARGE RATE
3.75
S 350
w v \
S 325 +—1—A
5 1 \
575 TYPICAL SLOPE = 3mV T0O 5mV
; PER % STATE OF CHARGE
2.50 ‘
2.25 | -
2.00
100 70 30 0
STATE OF CHARGE (%)

Figura 31: Curva de Descarga de uma Célula [18]

3.5  Confeccéo da Placa Eletronica

A lista de materiais utilizada para a confeccdo da placa eletrdnica do rob6 esta apresentada no a-

péndice A.

Apo0s a construcdo dos esquematicos, baseada nas informagdes coletadas durante o estudo dos

componentes, foi gerado um arquivo com extensdo “.brd”, denominado board. A fungéo de tal projeto

é tracar as trilhas por onde fluira a corrente elétrica, além de posicionar os componentes na placa, ou

seja, o board exibe como realmente ficara a placa, diferentemente do esquematico, onde o intuito prin-

cipal é apenas realizar a interligagéo entre componentes.

O projeto da placa pode ser visto na Figura 32.
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Figura 32: Projeto da Placa Eletronica

Os componentes sdo representados pela camada cinza, os pads pela camada verde, as trilhas da
parte superior de vermelho e as da inferior de azul. Os dois retangulos feitos com linhas tracejadas, nas
cores azul e vermelha séo para que o software faca com que todo espaco ndo preenchido por trilhas

seja conectado ao terra da placa, tanto em sua parte superior como na inferior.

Com o projeto da placa pronto, este deve ser exportado para um formato que a fresa, presente no
Departamento de Engenharia Elétrica, compreenda, ou seja, o arquivo com extensao “.brd” deve ser
convertido para um arquivo com extensdo “.Imd”, o qual consegue ser interpretado pelo software que

gerencia a fresa. Os procedimentos para realizar tal converséo estdo descritos no anexo A.

A Figura 33 foi renderizada utilizando o médulo Eagle 3D, possibilitando a melhor visualiza¢do
de como a placa ficaria quando confeccionada, ja a Figura 34 exibe a placa pronta em laboratdrio.
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4 RESULTADOS E DISCUSSOES

4.1 Resultados

Aplicando-se diferentes valores de duty cicle, com frequéncia igual a 30 kHz, como re-
comendado em seu manual, no pino denominado Enable e no denominado Input da ponte-H
L298, foram adquiridas as tensdes presentes na entrada do motor DC e com elas, foram cons-
truidas as curvas presentes na Figura 35, relacionando tais tensées com o duty cicle aplicado a
entrada do Cl L298.
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Figura 35: Tensdo de Saida x Duty Cicle
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Assumindo a curva descrita pelo duty cicle pulsado no pino Input do CI, ao multiplica-la
pela constante de rotacdo e eficiéncia do motor, iguais a 713 rpm/V e 81% respectivamente, o
gréfico presente na Figura 36 foi gerado, apresentando a velocidade de rotacdo do eixo do
motor contra o duty cicle na entrada da ponte-H, antes de ser reduzida pela caixa de reducao e

sem carga acoplada a ele.
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Figura 36: Velocidade do Eixo x Duty Cicle

4.2 Discussoes

O projeto inicialmente previa a utilizagio do PWM conectado ao pino Enable do CI
L298, porém ao observar a curva ndo linear descrita na Figura 35, tal conexdo foi remanejada
para o pino Input, tornando linear o equacionamento do acionamento dos motores, evitando
ter que remodelar as equacdes 2 e 3. Em contra partida, duas saidas de PWM tiveram que ser
utilizadas, ao passo que quando aplicados os pulsos ao pino Enable, apenas uma saida seria

necessaria.
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4.3 Melhorias

A primeira melhoria proposta, e mais impactante no projeto, é a contratacdo de empresas para
realizar a confecgdo das placas eletrénicas e soldagem de seus componentes, melhorando a qualidade
do produto final. Muitos pontos de contato entre trilha e terra foram encontrados nas placas, sendo
dessa maneira necessario realizar a checagem de todas antes de realizar a alimentacdo das mesmas. As
trilhas muitas vezes vinham com espessuras inferiores aquelas projetadas, fazendo com que as ampli-

tudes de correntes suportadas por elas sejam menores.

Modularizar a placa principal, dividindo-a em duas, uma responsavel pela comunicacao e proces-
samento de dados e outra somente pelo acionamento dos motores, separando, dessa maneira, a parte
digital da parte de poténcia e tornando mais barata a substituicdo de um dos dois mddulos, caso neces-
sario.

Utilizar motores brushless, que duram mais do que os micromotores DC e possuem maior efici-

éncia, além de serem menores que 0s com buchas.

Absorver o maximo desempenho do transceptor TRF-2.4G utilizando apenas um desses dispositi-
vos para realizar a transmissédo e recep¢do dos dados, diferente de como esta o projeto atual, um ope-
rando apenas como receptor e outro como transmissor, gerando economia para o projeto na ordem de

R$ 70,00 por transceptor.
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CONCLUSAO

Com os ensinamentos obtidos em sala de aula, associados a busca por informagdes adi-
cionais em livros, na internet e principalmente em manuais dos dispositivos utilizados, junta-
mente com o apoio e ajuda dos professores e técnicos do Departamento de Engenharia Elétri-

ca, foi possivel a construcdo da placa principal do rob6.

Essa placa possui tamanhos compativeis com as dimensGes maximas aceitas pelo robd,
além de contar com um desempenho aceitavel, seja na trasmissdo e recebimento de dados, no

processamento do MCU ou na movimentacao do robod.

O resultado final foi satisfatorio, pois, participando do Grupo de Estudos Avancados em
Robética - GEAR, o aluno p6de aplicar os conhecimentos obtidos em sala de aula, como tam-
bém aprender novas tecnologias e temas nao abordados pelos professores, além de melhorar
sua capacidade de trabalho em grupo e conseguir uma maior aproximacao de seus professores

e dos técnicos do setor.

Esse projeto, mesmo que concluido, ainda possui muitas melhorias a serem buscadas, al-
gumas delas j& apresentadas, porém varias ainda ndo levantadas. O ramo da robdtica, em es-
pecial o da inteligéncia artificial, ainda é pouco explorado no Brasil, porém muito avancado
em outros paises, restando assim aos demais estudantes de uma faculdade de ponta como é a

EESC/USP, tomar esse fato como motivacional para caminhar no sentido de tais paises.
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APENDICE

A. Lista de Materiais

A Tabela 9 lista todos 0s componentes necessarios na replicagdo da placa principal e suas

quantidades.

Tabela 9: Lista de Materiais Utilizados na Confec¢do da Placa Eletrdnica

Lista de Materiais

TRF2.4GHz 2

L298 2

Resistor 3W 0,1Q 4

Transistor TIP122 1

Regulador de Tensdo UA78M33CKC 1

LED Verde 2
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Push Botton 1

4066 1

Jumper 1

Pin Header 1x4 2

Capacitor 330nF 1

Resistor 100Q 5

Resistor 4,7kQ 1

Resistor 1IMQ 1

Pin Header 1x6 1

Fotodiodo 1
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B. Cadigos

Os codigos apresentados abaixo sdo responsaveis por realizar a movimentacao do robd através

do acionamento e controle de seus motores.

main.c

#include <p33FJ256MC710A.h>
#include <gtkernel.h>

#include <setup.h>

#include <kick.h>

#include <trf24g.h>

#include <geartucanomotor.h>

/* Configuration Bits */

_FGS(GSS_OFF & GCP_OFF & GWRP_OFF)
_FOSCSEL(FNOSC_FRCPLL & IESO_OFF)
_FOSC(FCKSM_CSDCMD & OSCIOFNC_ON & POSCMD_NONE)
_FWDT(FWDTEN_OFF & WINDIS_OFF & PLLKEN_ON)
_FPOR(PWMPIN_OFF & HPOL_ON & LPOL_ON)
_FICD(JTAGEN_OFF & ICS_PGD1)

/* Variable Declaration */

uint16 adConversion[highestADNumber+1] _ attribute__((space(dma),aligned(16)));
uint8 recepFreq;

uint8 transFreq;

uint8 robotName[4] = “"TUC";

uint8 stationName[] = "TUCS";

float batteryVoltage;

float kickVoltage;

uint8 adFlag;

uint8 adTypeFlag;

uint16 currentDrivers[4];
int main() {
uint8 ball;

float txBuffer[3];

* Oscillator Configuration */

CLKDIVbits.PLLPRE = 0; /*N1=5%*
CLKDIVbits.PLLPOST = 0; [*N2=2%*
PLLFBDbits.PLLDIV =41, /* M =16%/
RCONDbits. SWDTEN=0; /* Disable Watch Dog Timer */

/* Clock switching to incorporate PLL */

__builtin_write_ OSCCONH(0x01); /* Initiate Clock Switch to Primary */
__builtin_write_ OSCCONL(0x01); /* Start clock switching */
while(OSCCONDits.COSC != 0x01); /* Wait for Clock switch to occur */
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while(OSCCONDbits.LOCK != 0x01); /* Wait for Clock switch to occur */

setup(); /* General configuration */
setMotor ();

dsPICLED =1, /* Turn On dsPIC LED */
robotNumber(robotName); /* Define the robot number */
radioFreq(&recepFreq, &transFreq); /* Define the radio frequencies */
radioTxConfig(transFreq, robotName); /* Radio transmission configuration */
radioRxConfig(recepFreq, robotName); /* Radio reception configuration */
while (1) {
if(adFlag) {
if(kickVoltage >= kickLEDVoltageTest) I* Kick voltage check */
Nop();
/i kickLED =1; /* Turn on kicker LED */
else if(kickVoltage >= kick\VoltageTest)
setKick(255);
else
Nop();
1 kickLED = 0; /* Turn off kicker LED */
if(batteryVoltage <= batteryVoltageTest) /* Battery voltage check */
batteryLED = 1; /* Turn on battery warning LED */
else
batteryLED = 0; /* Turn off battery warning LED */
adFlag = 0;
if(ballSensor == 1) /* Ball sensor check */
ball = 1;
else
ball = 0;
txBuffer[0] = kickVoltage;
txBuffer[1] = batteryVoltage;
txBuffer[2] = (float) ball;
TRF24G_setActive(l, 0); /* Setting radio to active mode */
TRF24G_putData(1, stationName, sizeof(stationName), (uint8*) txBuffer, sizeof(txBuffer));
/* Sending data for TUCANO's base */
TXLED =1;
TRF24G_setStandBy(1); [* Setting radion on stand by mode */
}
}
}
void setup(void) {
ADConfig(); /* AD1 configuration */
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dmaConfig(); /* DMA configuration */

timersConfig(); /* Timers configuration */
portsConfig(); /* Ports configuration */

extIntConfig(); /* External Interruption configuration */
enableAD(); /* Enable AD */

enableDMA(); /* Enable DMA */

enableTimer3(); /* Enable Timer 3 */

setinterrupts(); /* Set Interruptions */

void robotNumber(uint8* robotName) {

robotName[3] = 0x30 + robotBit2*4 + robotBit1*2 + robotBit0;

void radioFreq(uint8* recepFreq, uint8* transFreq) {
if(rxFregBit == 0)

*recepFreq = 0; /* reception channel 0 */
else

*recepFreq = 1; /* reception channel 1 */
if(txFregBit == 0)

*transFreq = 0; [* transmission channel 0 */
else

*transFreq = 1, /* transmission channel 1 */

}

geartucanomotor.c:

#include <p33FJ256MC710A.h>
#include <math.h>

#include <geartucanomotor.h>

unsigned long pwmMax;

uintl6 pwmDC[4], pwmDCRef[4];
uint16 tensaoBat = 13.5;

float finalSpeed[4];

void setSpeed(uint8 motor, float speed) {
I finalSpeed[motor] = speed;
finalSpeed[motor] = 200;

void motorPinsConfig (void) {
/* Sets motors enable pins as outputs */
TRISEDits. TRISE9 = 0; /* Motor 0 Enable*/
TRISEDits. TRISE8 = 0; /* Motor 1 Enable */
TRISBbits. TRISB4 = 0; /* Motor 2 Enable */
TRISBDbits. TRISB5 = 0; /* Motor 3 Enable */
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/* Sets motors current sensors pins as inputs */

TRISBbits. TRISBO = 0; /* Motor 0 Current */
TRISBbits. TRISB1 = 0; /* Motor 1 Current */

TRISBbits. TRISB2 = 0; /* Motor 2 Current */
TRISBbits. TRISB3 = 0; /* Motor 3 Current */

/* Sets motors PWM pins as outputs */

TRISEbits. TRISEOQ = 0; /* PWMOL */
TRISEDbits. TRISE1 = 0; /* PWMOH */
TRISEDits. TRISE2 = 0; [* PWML1L */
TRISEDits. TRISE3 = 0; /* PWM1H */
TRISEbits. TRISE4 = 0; [* PWM2L */
TRISEDbits. TRISES5 = 0; /* PWM2H */
TRISEbits. TRISE6 = 0; /* PWM3L */
TRISEbits. TRISE7 = 0; /* PWM3H */

/* Sets motors encoders pins as inputs */

TRISCbits. TRISC1 = 1; /* Encoder 0 */
TRISCbits. TRISC2 = 1; /* Encoder 1 */
TRISCbits. TRISC3 = 1; /* Encoder 2 */
TRISCbits. TRISC4 = 1; /* Encoder 3 */

void pwmConfig (void) {

uint16 ptperValue;

/* PWM max value */

pwmMax = 2*FCY/FPWM;

/* PTPER value */
ptperValue = (FCY/(FPWM*PTMRPRESCALER))-1;

/* PWM TIME BASE CONTROL REGISTER */

/* PWM time base is off */

P1TCONDbits.PTEN = 0;

/* PWM time base operates in a Free-Running mode */
P1TCONDbits.PTMOD = 0;

/* PWM time base input clock period is TCY (1:1 prescale) */
P1TCONDbits.PTCKPS = 0;

/* 1:1 postscale */

P1TCONDbits.PTOPS = 0;

/* PWM time base runs in CPU Idle mode */
P1TCONDits.PTSIDL = 0;

/* PWM TIMER COUNT VALUE REGISTER -> Not used */
/* PWM Time Base Register Count Value bits */

P1TMRDbits.PTMR = 0;

/* PWM TIME BASE PERIOD REGISTER */
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P1TPERDits.PTPER = ptperValue;

/* SPECIAL EVENT COMPARE REGISTER -> Not used */
P1SECMPDits.SEVTCMP = 0;
P1SECMPDits.SEVTDIR = 0;

/* PWM CONTROL REGISTER 1 */

/* PWMNXL pin is enabled for PWM output */
PWM1CON1bits.PEN1L = 1;

PWM1CON1bits.PEN2L = 1;

PWM1CON1bits.PEN3L = 1;

PWM1CON1bits.PEN4L = 1;

/* PWMxH pin is disabled; 1/0 pin becomes general purpose /O */
PWM1CON1bits.PEN1H =1;

PWM1CON1bits.PEN2H =1;

PWM1CON1bits.PEN3H =1;

PWM1CON1bits.PEN4H = 1;

/* PWM 1/O pin pair is in the Independent PWM Output mode */
PWM1CON1bits.PMOD1 = 1;

PWM1CON1bits.PMOD2 = 1;

PWM1CON1bits.PMOD3 = 1;

PWM1CON1bits.PMOD4 = 1;

/* PWM CONTROL REGISTER 2 */

[* Updates from Duty Cycle and Period Buffer registers are enabled */

/* Not used */

PWM1CON2bits.OSYNC = 0;

/* Updates to the active PDC registers are synchronized to the PWM time base */
PWM1CON2bits.IUE = 0;

/* Not used */

PWM1CON2bits.SEVOPS = 0;

/* DEAD-TIME CONTROL REGISTER 1 ->Not used */
P1DTCON1bits.DTA = 0;

P1DTCON1bits.DTAPS = 0;

P1DTCON1bits.DTB = 0;

P1DTCON1bits.DTBPS = 0;

/* DEAD-TIME CONTROL REGISTER 2 -> Not used */
P1DTCONZ2bits.DTS1I = 0;

P1DTCON2bits.DTS1IA = 0;

P1DTCONZ2bits.DTS2I = 0;

P1DTCON2bits.DTS2A = 0;

P1DTCONZ2bits.DTS3I = 0;

P1DTCON2bits.DTS3A = 0;

P1DTCONZ2bits.DTS41 = 0;

P1DTCONZ2bits.DTS4A = 0;

/* FAULT A CONTROL REGISTER -> Disabled */
P1FLTACONDits.FAEN1 = 0;
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P1FLTACONDits.FAEN2 = 0;
P1FLTACONDits.FAEN3 = 0;
P1FLTACONDits.FAEN4 = 0;
P1FLTACONDiIts.FLTAM = 0;
P1FLTACONDits.FAOVI1L = 0;
P1FLTACONDiIts.FAOV1H = 0;
P1FLTACONDits.FAOV2L = 0;
P1FLTACONDiIts.FAOV2H = 0;
P1FLTACONDits.FAOV3L = 0;
P1FLTACONDiIts.FAOV3H = 0;
P1FLTACONDits.FAOVAL = 0;
P1FLTACONDiIts.FAOV4H = 0;

/* FAULT B CONTROL REGISTER -> Disabled */
P1FLTBCONDits.FBEN1 = 0;
P1FLTBCONDits.FBEN2 = 0;
P1FLTBCONDits.FBEN3 = 0;
P1FLTBCONDits.FBEN4 = 0;
P1FLTBCONDits.FLTBM = 0;
P1FLTBCONDits.FBOV1L = 0;
P1FLTBCONDbits.FBOV1H = 0;
P1FLTBCONDits.FBOV2L = 0;
P1FLTBCONDbits.FBOV2H = 0;
P1FLTBCONDits.FBOV3L = 0;
P1FLTBCONDbits.FBOV3H = 0;
P1FLTBCONDits.FBOVAL = 0;
P1FLTBCONDits.FBOV4H = 0;

/* OVERRIDE CONTROL REGISTER */

/* Output on PWMXx I/O pin is controlled by the PWM generator */
P1O0VDCONDbits.POVDI1L = 1;

P1OVDCONDits.POVD1H = 1;

P10OVDCONDbits.POVD2L = 1;

P1OVDCONDits.POVD2H = 1;

P10VDCONDits.POVD3L = 1;

P1OVDCONDits.POVD3H = 1;

P10OVDCONDbits.POVDAL = 1;

P1OVDCONDits.POVD4H = 1;

PWM1CON2bits.UDIS = 1;

/* PWM DUTY CYCLE REGISTERS */
PDC1=0;

PDC2 =0;

PDC3=0;

PDC4 =0;

PWM1CON2bits.UDIS = 0;

void pwmEnable (void) {
/* PWM time base is on */
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P1TCONDits.PTEN = 1;

void encoderConfig (void) {
T6CON = 0x0002;
T7CON = 0x0002;
T8CON = 0x0002;
T9CON = 0x0002;

[* Zera os contadores */
TMR6 = 0x0000;
TMR7 = 0x0000;
TMR8 = 0x0000;
TMR9 = 0x0000;

/* Seta os periodos */
PR6 = OXFFFF;
PRY = OXFFFF;
PR8 = OXFFFF;
PRY = OXFFFF;

void encoderEnable (void) {
* Liga os timers externos */
T6CONDits. TON = 1;
T7CONDits.TON = 1;
T8CONDits. TON = 1;
T9CONDiIts. TON = 1;

void sampleTimeConfig (void) {

unsigned long long perCalc;

perCalc = (FCY*SAMPLE_TIME)/1000;

T5CONDits. TON = 0; // Disable Timer

T5CONDiIts. TCS = 0; // Select internal instruction cycle clock
T5CONDits. TGATE = 0; // Disable Gated Timer mode
T5CONDits. TCKPS = 0b00; // Select 1:1 Prescaler

TMRS5 = 0x00; // Clear timer register

PR5 = perCalc; // Load the period value

IPC7bits. T5IP = 0x01; // Set Timer5 Interrupt Priority Level
IFS1bits. T5IF = 0; // Clear Timer5 Interrupt Flag
IEC1bits. T5IE = 1; // Enable Timer5 interrupt

void initSampling (void) {
T5CONDits. TON = 1; // Start Timer



void convertVel (void) {
float tensaoRotacao[4];
float k;

uint8 i;

k = (2.0*M_PI*CONSTANTE_ROTACAO)/(60.0*CAIXA_REDUCAO);

for (i = 0; iKNUM_MOTORES; i++){
tensaoRotacao[i] = fabs(finalSpeed[i]/k);
pwmDCIi] = (tensaoRotacao[i]*pwmMax)/(tensaoBat-1.6);

void motorDirection (void) {

/* Motor 0 */

if (finalSpeed[0] > 0) {
P1OVDCONDits.POVDI1L = 1;
P10VDCONDbits.POVD1H = 0;
P10VDCONDits.POUT1H = 0;

}

else if (finalSpeed[0] < 0) {
P10VDCONDbits.POVDI1L = 0;
P1OVDCONDits.POVD1H =1;
P10VDCONDbits.POUTIL = 0;

}

else {
P10VDCONDbits.POVDIL = 0;
P1OVDCONDits.POUTLL = 1;
P10VDCONDbits.POVD1H = 0;
P1OVDCONDits.POUT1H = 1;

}

/* Motor 1 */

if (finalSpeed[1] > 0) {
P10VDCONDbits.POVD2L = 1;
P10VDCONDits.POVD2H = 0;
P10VDCONDbits.POUT2H = 0;

}

else if (finalSpeed[1] < 0) {
P10VDCONDits.POVD2L = 0;
P1OVDCONDits.POVD2H =1;
P10VDCONDits.POUT2L = 0;

}

else {
P1OVDCONDbits.POVD2L = 0;
P1OVDCONbits.POUT2L = 1;
P1OVDCONDits.POVD2H = 0;
P1OVDCONDits.POUT2H = 1;

}
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/* Motor 2 */

if (finalSpeed[2] > 0) {
P1OVDCONDits.POVD3L = 1;
P10OVDCONbits.POVD3H = 0;
P1OVDCONDits.POUT3H = 0;

}

else if (finalSpeed[2] < 0) {
P1OVDCONbits.POVD3L = 0;
P1OVDCONDits.POVD3H =1;
P1OVDCONbits.POUT3L = 0;

}

else {
P10VDCONDits.POVD3L = 0;
P10OVDCONDits.POUT3L = 1;
P10VDCONDits.POVD3H = 0;
P10OVDCONDits.POUT3H = 1;

}

/* Motor 3 */

if (finalSpeed[3] > 0) {
P1OVDCONDits.POVDAL = 1;
P10VDCONDbits.POVD4H = 0;
P1OVDCONDits.POUT4H = 0;

}

else if (finalSpeed[3] < 0) {
P1OVDCONDits.POVDAL = 0;
P10OVDCONDits.POVD4H =1;
P1OVDCONDits.POUTAL = 0;

}

else {
P10VDCONDbits.POVDAL = 0;
P1OVDCONDits.POUTAL = 1;
P10VDCONDbits.POVD4H = 0;
P1OVDCONDits.POUT4H = 1;

}

void motorVel (void) {

inti;
PWM1CONZ2bits.UDIS = 1;
PWMDCO = pwmDC[0];
PWMDC1 = pwmDC[1];
PWMDC2 = pwmDC[2];
PWMDC3 = pwmDC[3];
PWM1CON2bits.UDIS = 0;

for (i=0; ikNUM_MOTORES; i++) {
pwmDCRef[i] = pwmDCJi];
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void motorEnable (void) {

Nop();
ENABLE_MO = 1;
Nop();
ENABLE_M1=1;
Nop();
ENABLE_M2=1;

Nop();
ENABLE M3 =1;

void motorDisable (void) {

ENABLE_MO0 =0;
ENABLE_M1 =0;
ENABLE_M2 =0;
ENABLE_M3=0;

void __attribute__((__interrupt__, no_auto_psv)) _T5Interrupt(void) {

/*

inti;

float k;

float velRad[4], encoderCount[4], tensaoRotacao[4], encoderPwm[4], error[4], outP[4], outl[4];
float previousOutl[4], previousError[4];

k = (2.0*M_PI*CONSTANTE_ROTACAO)/(60.0);
encoderCount[0] = ENCODER_MO;
encoderCount[1] = ENCODER_M1,;
encoderCount[2] = ENCODER_M2;
encoderCount[3] = ENCODER_M3;

for (i=0; ikNUM_MOTORES; i++) {
velRad([i] = (2.0*M_PI*encoderCount[i]*1000.0)/(SAMPLE_TIME*RESOLUCAO_ENCODER);
tensaoRotacao[i] = fabs(velRad[i]/k);
encoderPwm[i] = (tensaoRotacao[i]*pwmMax)/(tensaoBat-1.6);

error[i] = pwmDCREfTi] - encoderPwm[i];

outP[i] = KP*error[i];

outl[i] = previousOutl[i] + KP*KI*previousErrorf[il;
pwmDCTi] = outP[i] + outl[i];

previousOutl[i] = outl[i];

previousError[i] = error[i];

PWMDCO = pwmDC[0];
PWMDC1 = pwmDC[1];
PWMDC?2 = pwmDC[2];
PWMDC3 = pwmDC[3];
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ENCODER_MO0 =0;
ENCODER_M1 =0;
ENCODER_M2 =0;
ENCODER_M3 =0;
*/
IFS1bits. T5IF = 0; // Clear Timer5 Interrupt Flag

void setMotor (void) {
motorPinsConfig ();
pwmConfig ();
encoderConfig ();
sampleTimeConfig ();
encoderEnable ();
pwmEnable ();
initSampling ();

void updateMotor (void) {
convertVel ();
motorDisable ();
motorDirection ();
motorVel ();
motorEnable ();

}

geartucanomotor.h

#ifndef GEARTUCANOMOTOR H_
#define_GEARTUCANOMOTOR_H_ 1

#include <p33FJ256MC710A.h>

#define uint8 unsigned char

#define uint16 unsigned int

/* Constants */

#define M_P1 3.1415926

#define CONSTANTE_ROTACAO 713.0
#define CAIXA_REDUCAO 1.0

#define NUM_MOTORES 4.0

#define ROTACAO_MAX 8100.0
#define SAMPLE_TIME 10.0
#define RESOLUCAO_ENCODER 512.0
#define KP 1.6

#define  KI10.5

#define PTMRPRESCALER 1

#define FPWM 32500
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#endif

#define FCY 39613750

/* Motor Enable */

#define ENABLE_MO PORTEDits.RE9
#define ENABLE_M1 PORTEDbits.RE8
#define ENABLE_M2 PORTBDbits.RB4
#define ENABLE_M3 PORTBbits.RB5

* Motor Current Sensor */

#define CURRENT_MO PORTBbits.RBO
#define CURRENT_M1 PORTBbits.RB1
#define CURRENT_M2 PORTBbits.RB2
#define CURRENT_M3 PORTBbits.RB3

/* Motor Encoder */

#define ENCODER_MO0 TMR7
#define ENCODER_M1 TMR6
#define ENCODER_M2 TMR9
#define ENCODER_M3 TMR8

/* Duty Cicle Registers */
#define PWMDCO PDC1
#define PWMDC1 PDC2
#define PWMDC2 PDC3
#define PWMDC3 PDC4

/* Functions */

void setSpeed(uint8 motor, float speed);
void motorPinsConfig (void);
void pwmConfig (void);

void pwmEnable (void);

void encoderConfig (void);
void encoderEnable (void);
void sampleTimeConfig (void);
void initSampling (void);

void convertVel (void);

void motorDirection (void);
void motorVel (void);

void motorEnable (void);

void motorDisable (void);

void setMotor (void);

void updateMotor (void);
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ANEXOS

A. Descritivo de como exportar arquivos do Eagle PCB para Fresa LPKF

Fonte: http://optics.eee.nottingham.ac.uk/eagle/eagle2lpkf at_eee.html

Eagle PCB -> LPKF Milling Machine Mini-How-To

Instructions for users in EEE, University of Nottingham
EAGLE 4.09rl (Linux) CircuitCAM 3.0 (99) and BoardMaster 3.0 (45)
Steve D. Sharples
1. SPECIFIC ISSUES TO EEE

1a. Design rules

The Eagle software comes with a set of default physical design rules... such as how close together
tracks may be, how close the copper layer can be to the edge of the board etc. Unfortunately, these are
just a little bit too good for the milling machine within the School, so a set of design rules suitable for
in-house board-making has been designed. It is important that the "in-house™ design rules are
used, rather than the "'standard™ rules, otherwise your circuit may not be milled correctly. In
practice, this means (for each project that you work on) before you do any routing (especially auto-

routing) the following steps must be taken:

once you have "created a board from schematic”, click on the "DRU" button
a window will pop up, it will probably say "EAGLE Design Rules"

click on the "Load" button

navigate your way to the following directory: /home/share/eagle/local_dru/
double-click on "steve.dru" (right click to download)

click on "OK"
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1b. Extra layers (for the milling machine)

As explained above, milling a PCB is a slightly different process to the normal process of making
a PCB. in particular:

o the board starts out as blank copper, and the machine mills out either:
o athin line around the copper tracks/pads (this is the default behaviour) or:
o all areas other than the copper tracks/pads
o there currently no facility to print text onto PCBs with a pen... any text you want must be
milled into the copper. You wouldn't normally want to mill around each letter of the text (as
with tracks), you would normally just want to mill out the letters of the text.

Because of these differences and extra choices, it is necessary in your design to use special layers on
your board layout if you want to:

e add any text
o have areas of the board where the tracks are not only isolated, but there is also no extra copper
at all
It is important to follow the following conventions, otherwise your boards may not be exported

and manufactured correctly

Layer conventions used

Layer Name Colour There by de- Used for...
fault?
41 tRestrict Diagonal red s- Yes Areas on Top layer that you wish
tripes to be completely milled out except

for tracks, pads and vias

42 bRestrict Diagonal blue Yes Areas on Bottom layer that you
stripes wish to be completely milled out

except for tracks, pads and vias

117 tText Usually white No For text on Top layer... will be

milled out with 0.2mm cutter

118 bText Usually white No For text on Bottom layer... will be
milled out with 0.2mm cutter

77



Please note the following, which will affect the results given by any Design Rule check:

e Any areas of tRestrict or bRestrict that go over tracks, vias or bads will be picked up as a DRC
error. For this reason it is recommended to place these areas once all "genuine" DRC errors
have been sorted out

e The tText and bText layers are not checked for DRC errors. Since any objects (text, lines) on
these layers will be milled out, make sure that none of your text overlays any tracks on the
same side.

o Remember to "mirror" any text you put on the bText layer... otherwise it will appear back-to-
front on your completed design.

1c. Shared files in Eagle: /home/share/eagle/

We have set up a system whereby circuits, component libraries, script files (used to perform use-
ful repetetive tasks) developed by one person can be shared amongst everyone else. It involves the use
of a shared directory which is located at /home/share/eagle/. Within this are sub-directories...

o local_completed_projects - any circuits that you've made and completed, you are free to put
here so that other people can see them and perhaps learn from them

e local_dru - local design rules (see section 1a above)

o local_Ibr - library elements (ie components) developed "in-house" that didn't come supplied
with the Eagle software. In particular, we've developed quite a few R.F. Minicircuits compo-
nents, added some additional connectors, op-amps, encoders/decoders etc. If you develop any
library elements of your own, it would be appreciated if you would place them in this directo-
ry. It's possible to change the permissions such that other users may read them (ie use them in
their designs) but not alter them (potentially mucking up your beautiful components)... see
Steve on how to do this if you don't already know. Any library elements added to this directo-
ry will automatically be added to the overall component library (so when you "add" a compo-
nent, anything in /home/share/eagle/local_lbr/ will be on the list).

2. THE EXPORT/IMPORT PROCEDURE OVERVIEW

You'd think that everyone would use the same kind of file standard, wouldn't you? Well, they
kind of do, and they kind of don't. Each PCB design package uses its own file standard, which con-
tains much more informations about the design than just physically where the tracks are laid... since
different design packages are capable of different things, this makes sense. Once you have finalised
your design process, you just want to tell the board manufacturer where to drill the holes and place the

copper. For this you use Excellon drill files and Gerber files.

All board manufacturers accept these file formats, and they should adher to a strict standard. What
they do with them and how they process them is down to the individual board maker. In the case of
boards made in EEE using the milling machine, the Gerber and Excellon files are imported into a pro-
gram called CircuitCam which will then produce files that consist of routes for the milling machine to
mill out (to isolate tracks), places to drill holes, drill sizes etc. Yet another file standard... anyway, it's
probably worth looking at the following picture:
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EAGLE software EAGLE files:
PCB design design.sch, design.brd etc

i l EXPORT (using "CAM processor™)

GERBER files: Excellon drill files:
design.top, design.bottom, design.drd, design.drl
design.rubout_top,
design.text_top
elc.

* IMPORT into CircuitCAM

CIRCUITCAM software CAM files:

- ) iles:
Track insulating, design.cam
outline milling etc

* EXPORT from CircuitCAM
LMD" file:
design.LMD

* IMPORT into Board Master

Board Master so.ft\.vare Board Master job files:
Controls the milling designJOB
machine

'

[ Completed PCB }

Make sense yet? Lots of different stages, involving 2 or 3 different programs on 2 operating sys-

tems. You'll be fine....

3. EXPORTING FILES FROM EAGLE

start Eagle

open up your project... board and schematic

in the "Board" window, type: run drillcfg

a window pops up, asking for units... default is mm, select INCH.

another window will show you the file it's created... something like:
TO1 0.024in
TO2 0.031in
TO3 0.032in
T04 0.040in

click "Ok™ it'll suggest "design.drl™ as the output filename.

click "Save"

in the "Board" window, click on the "CAM" icon (next to the printer icon)
click File -> Open -> Job...
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double-click "EEE_milling.cam™ (right click to download)

click "Process Job" - it is possible during this process that a warning window saying "No lay-
ers active!" will pop up... this means that you have not used all the layers you could do. This is
normal, if you (eg) don't have text on either top or bottom side and so have not added the tText
or bText layers. Click "Ok" to each of these warnings.

The following GERBER files will have been created (assuming your design is called "design"):

design.top
design.bottom
design.outline
design.text_bottom
design.text_top
design.rubout_top
design.rubout_bottom

As you can see, there is one Gerber file per layer. The following Excellon drill files will have been

created:

design.drl - list of tools (ie drill sizes)... also known as the "Rack file"
design.drd - list of positions of holes for each drill size

These are the files you need to import into CircuitCAM (or give to the technicians on the

9th floor to process). So you'll be wanting to put them on a floppy disc....

4.

open up a "konsole"/"shell" window

put a floppy disc in the disc drive

change to the directory where your files are stored, eg:
cd ~/eagle/my current design/

type: eagle2floppy

once told to do so, remove the disc from the drive

IMPORTING THE FILES INTO CIRCUITCAM

4a. The Gerber Files (Top, Bottom and BoardOutline etc)

start CircuitCam

click File -> Import

find your files, select "design.bottom” ... click "Ok"
CircuitCam should recognise it as "Gerber-X"

in the "Aperture/Tool list" box, type "bottom" (or something)
Select "Bottom Layer" ... click "OK"

Bottom Layer tracks and pads should appear (in green)
click File -> Import

select "design.top” ... click "Ok"

CircuitCam should recognise it as "Gerber-X"

in the "Aperture/Tool list" box, type "top"” (or something)
Select "Top Layer" ... click "Ok"
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Top Layer tracks and pads should appear (in red)

import the BoardOutline layer in the same way as the above 2 layers

the BoardOutline should appear (in yellow)

If you created any text layers, or any rubout layers, import them into CircuitCAM the
same way

4h. The Excellon Drill Data

click File -> Import

select "design.drl™ ... click "Ok™

click the "Apertures/Tools select™ button

select "Eagle_Excellon.txt" from the "Aperture/Tool Template™ list

in the "Aperture/Tool list” box, type "drills" (or something)

click "Ok" - a window should pop up saying "4 apertures were recognised"” (or some-
thing) ... click "Ok"

click File -> Import

select "design.drd” ... click "Ok"

CircuitCam should recognise it as "Excellon™

in the "Aperture/Tool list” box, SELECT "drills" FROM THE LIST

Select "DrillPlated” (or DrillUnplated for single-sided boards) layer... click "Ok"
The drill holes should appear (in blue) - note that if you have selected the destination
layer as "DrillUnplated” you won't be able to see them... change the display order us-
ing View -> Layers...

5. INSULATING THE COPPER

click Edit -> Insulate...
select "Bottom layer"
click "Run"

click Edit -> Insulate...
select "Top layer"
click "Run"

6. BOARD CUT-OUT

The aim of this bit is to create a "Cut-out" around the outside of the board outline. A

large, 2mm diameter milling bit will mill around your board, to make it the correct size. You

first need to run the "contour router,"” by telling which layer contains the Board Outline. It is,

unsurprisingly, the "BoardOutline™ layer...:

click Edit -> Contour Routing...

select "Source layer" ... "BoardOutline"
select "Destination layer" ... "CuttingOutside"
tool should be "Contour Router 2.0mm long"
click "Run"
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You now need to put some gaps in the large gray rectangle, so that the milling machine does
not mill out your board completely (it can't do this, otherwise it would fly off the milling ma-

chine)...:

click near the grey CuttingOutside rectangle to select it

use the "+" and "-" keys on the keypad to move the "*" around the rectangle
press "Ctrl-g" to make a gap in the middle of one side

use the "+" and "-" keys to move the "*" around to the other side

press "Ctrl-g" to make a gap in the middle of the other side

de-select everything (right-click -> Cancel)

We now need to ERASE the BoardOutline layer. (If we don't do this, the milling machine

will attempt to mill out this layer.)

o click on the INSIDE of the BoardOutline layer (yellow) to select a part of it

« if you selected the correct object (the outline should go pale yellow) then click the "se-
lect layer" button (looks like an arrow pointing into a parallelogram) to select ALL ob-
jects in the BoardOutline layer

« once selected, ERASE the layer (using the "X" button) - all the yellow should go

7. SAVING AND EXPORTING

e click File -> Save As...

e save as "design.cam” ... MAXIMUM 8 LETTERS (BoardMaster is very old)

 click File -> Export -> LPKF CircuitBoardPlotter... saves "design.LMD"
The 9th-floor workshop technicians need either the "design.cam” or the "design.LMD" files...
the design.cam file is larger (so may not fit on a floppy disc) but it does allow them to check

the design in CircuitCAM. The .LMD file can only be checked in BoardMaster.

8. IMPORTING BOARD INTO BOARDMASTER

 start BoardMaster

o click File -> Import -> LMD/LPR...

o select your file "design.LMD" ... click "Ok"

o check everything's there and ok (view both sides, select "Real Tools" etc)

Any comments, or even if you read this Mini-How-To and actually use it, please mail me
(remove the no.spams). Also mail me if I've failed to reference a source of knowledge for
anything, I'll be happy to correct any omissions.

Feel free to modify, redistribute etc under the terms of the GNU Public License

Hope it's useful!
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